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Uvod

Ova zbirka je namenjena pripremi za Regionalno i Republičko takmičenje polaznika regionalnih centara za talente iz oblasti Informatike.
Zbirka nema rešenja, ali do rešenja se lako dolazi istraživanjima na netu i/ili čitanjem udžbenika iz Informatike za osnovnu školu. 
Dodatna prednost ovog pristupa je mogućnost da deca tokom istraživanja po internetu dođu do ideja šta još mogu da rade u svojim projektima. Iako većina pitanja premašuje ono što se radi u osnovnoj školi, treba imati na umu da je ovo takmičenje talentovane dece iz oblasti informatike, a do sada smo imali prilike da se uverimo da je poznavanje ove materije dece koja su zainteresovana za ovu oblast daleko ispred onoga što se obrađuje u osnovnoj školi. 
Pitanja su podeljena u nekoliko osnovnih kategorija kao što su Opšte računarske teme (operativni sistemi, arhitektura računara, komandna linija, mreže, itd...) i teme vezane za web tehonologije. Pitanja iz oblasti opštih računarskih tema su takva da deca treba da imaju jedno solidno opšte računarsko obrazovanje kako bi uspešno na njih odgovorila. Određen procenat dece koji se aktivno bave ovom oblašću će odgovoriti na većinu ovih pitanja i bez konsultovanja literature i interneta, dok će ostali morati da se pomuče oko pronalaženja adekvatnih odgovora. Međutim u procesu pronalaženja odgovora saznaće još interesantnih i korisnih informacija vezanih za date oblasti što će im koristiti ako se u budućnosti budu aktivno bavili oblašću Informatika. 
Većina radova dece u osnovnoj školi u zadnjih nekoiko godina su iz sledećih oblasti: PowerPoint prezentacije, Web prezentacije, Jednostavnije Web aplikacije i C# ili VB aplikacije. Primećena je tedencija da se sve više dece iz osnovnih škola opredeljuju za web aplikcije i prezentacije kao i povećano interesovanje za C# aplikacije. Iz ovog razloga akcenat u testovima je dat, pored opštih računarskih tema, i na web tehnologije HTML, CSS i JS. Smatramo da bi deca u osnovnoj školi trebali da savladaju ove tehnologije kako bi u srednjoj školi mogli da se bave naprednijim tehnologijama. C# iako je interesantan izvesnom broju dece, za većinu dece u osnovnoj školi je ipak van mogućnosti savladavanja, pa smo smatrali da bi bilo ne adekvatno da pitanja budu i iz ove oblasti.  Osim toga web tehnologije su sve zastupljenije u informatičkom okruženju pa je poznavanje ovih osnovnih klijentskih tehnologija presudno za dalje usavršavanje u oblasti Informatika. 
Na svako pitanje postoji samo jedan tačan odgovor. Većina pitanja su preuzeta sa predhodnih takmičenja a neka od njih su se prvi put pojavila u ovoj zbirci. Na budućim takmičenjima oko 80% pitanja će biti iz ove zbirke, dok će oko 20% biti potpuno nova pitanja.  

Takmičenje talentovane dece u oblasti Informatika

Takmičenje u oblasti informatike, talentovane dece se održava svake godine. Prijava radova se vrši do januara meseca, predaja radova do kraja aprila dok su takmičenja u maju (regionalno) i junu (republičko). Takmičenje se sastoji iz dva dela, u prvom delu se rade testovi opšteg Informatičkog obrazovanja, dok se u drugom delu vrši odbrana projekata-radova. Odbrana projekata se radi pred komislijom od tri člana. Članovi komislije su pročitali sve radove pre takmičenja i na samoj odbrani treba da ustanove u da li je takmičar samostalno radio rad i kakvo mu je poznavanje materije iz koje je radio rad. Odbrana se sastoji od prezentacije rezultata rada i ne bi trebalo da traje duže od 15 min, nakon čega slede pitanja komislije. 50% poena se dobijaju iz rezultata testa opšteg informatičarskog znanja a 50% kao ocena komisije. Osvojena mesta se računaju po ukupnom broju poena koji se osvoje. 
Teme radova

Osim dela takmičenja sa pitanjima, glavni deo takmičenja je ipak pisanje naučno-stručnog rada, i prezentacija projekta. Oblast Informatika je dosta specifična, jer se deca samostalno dosta interesuju za ovu oblast i van onoga što se radi u školama. Zbog toga na takmičenjima imamo vrlo raznolike radove na raznim nivoima za isti uzrast. Primećena je tedencija interesovanja za izradu web prezentacija i aplikacija. Takođe ima sve više dece koja poznaju C# i/ili druge napredne tehnike programiranja. Da bi se izbeglo prepisivanje naučno-stručnih radova iz ove oblasti, kojih postoji jako puno na netu, od dece se, uglavnom, očekuje da nešto konkretno i samostalno kreiraju. Odnosno projekti u oblasti informatke su obično praćeni sa konkretnim rezultatima, najčešće u obliku programa, web prezentacije, i sl. Ponekad se javljaju i radovi koji su urađeni kao projekat. Na primer, projekat školske mreže, projekat naplate preko bluetooth-a, robota podmornice, itd... Većina radova u osnovnoj školi se baziraju na demonstraciji dece da su savladali određenu tehnologiju, ili češće skup tehnologija. 
Pristup rada sa decom u osnovnoj školi treba da se zasniva na motivaciji dece da se bave ovom oblašću više nego da se forsiraju ka postizanju rezultata. Deca iz osnovnih škola su na različitim nivoima poznavanja Informacionih tehnologija, i tokom njihovog bavljenja ovom oblašću oni dostižu jedan visoki nivo poznavanja oblasti što je vrlo dobra osnova za takmičenja i rezultate u srednoj školi. Treba motivisati ovu decu da proučavaju što više različitih oblasti Informatike, i da pronađu šta ih lično najviše interesuje. Poželjno je da tokom osnovne škole savladaju web tehnologije HTML, CSS i JS a za naprednije je poželjno da savladaju neki objektno orijentisan programski jezik poput Jave ili C#-a. PHP je takođe zgodan za napredniju decu u osnovnoj školi jer može da se iskombijuje sa poznavanjem klijentskih web tehnologija, u kreiranju nekog složenijeg projekta. 
UPUTSTVO ZA PISANJE ISTRAŽIVAČKOG /NAUČNOISTRAŽIVAČKOG/  RADA

IZ

INFORMATIKE

Predgovor

Svakom početniku u istraživanju, uglavnom nije poznato šta se može istraživati i na koji način, pa mu je odmah na početku, potrebna odgovarajuća pomoć.

Pripreme za izradu naučno-istraživačkog rada se sprovode u regionalnim centrima i obuhvataju: 

0 predavanja,

1 konsultacije-vežbe,

2 izbor teme.

U želji da se pomogne potencijalno talentovanim i da se otklone eventualne teškoće oko pisanja rada, kao i da se ubrza i ujednači tehnička priprema istih, u tekstu koji sledi navode se smernice koje metodološki i ilustrovano upućuju svakog polaznika na :

0 *  način pisanja istraživačkog /naučnoistraživačkog/ rada

1  *  tehničku obradu rezultata istraživačkog /naučnoistraživačkog/  rada

Ukoliko neko od polaznika u svom radu ne primeni date smernice u ovom uputstvu automatski će biti diskvalifikovan i time izgubiti pravo da sa svojim radom učestvuje na Smotri.  

Napomena: 

1. Jedan naučno istraživački rad može raditi najviše dva polaznika-autora, ili naravno jedan polaznik-autor samostalno.

2. Jedan polaznik može učestvovati sa radom iz samo jedne naučne oblasti.

0 Način pisanja  istraživačkog /naučnoistraživačkog/ rada

Pisanje  istraživačkog rada podrazumeva unapred osmišljen i razrađen koncept /plan/ rada.

Za svako istraživanje plan pisanja sadrži strukturu rada. 

Struktura rada obuhvata sledeće delove:

a.  naslov rada 

b.  Rezime 

c.  Uvod 

d.  listu simbola 

e.  alati i metodika rada

f. rezultate istraživanja i diskusiju

i.  Zaključak    i

j.   citiranu literaturu 

Ovi delovi strukture su poglavlja u radu i pišu se kao podnaslovi.  Svaki od navedenih podnaslova ima svoju unutrašnju strukturu sa karakteristikama koje će u daljem tekstu biti detaljno definisane i opisane.

a.  naslov rada

Naslov rada je potvrđena ili modifikovana radna formulacija postavljenog pitanja za naučno istraživanje. 

U svakom naslovu bitno je istaći težište istraživanja, bez opterećenja 

suvišnim rečima. Zato naslov mora biti kratak, jasan, precizan privlačan i invetivan.

Poznati svetski časopisi ograničavaju dužinu naslova na 50 – 55 slova.

Maksimalna dužina naslova može biti 70 slovnih mesta.

Naslov rada se piše na srpskom i engleskom jeziku centrirano, velikim slovima. 

Ispod naslova rada pišu se imena autora, razred i škola, naziv centra za talente i puno ime i prezime mentora sa titulom, zvanjem i mestom zaposlenja.

b.  Rezime 

Rezime je sažeto prikazivanje sadržine iz čitavog rada.

 U rezimeu se prikazuje :

1. svrha i cilj projekta;

2. primenjena metoda rada;

3. ostvareni rezultati  uz apostrofiranje njihovih ključnih  vrednosti:

4. bitni zaključci:

    Dužina teksta rezimea je 200 – 250 reči.

    Ključne reči: U produžetku teksta rezimea navode se ključne reči na srpskom jeziku.

  Obično se odabere do 6 najznačajnijih reči koje asocijativnim svojstvima    najbolje prezentuju bit rada.

 Skup reči odrediti tako da su prethodne reči značajnije za sadržaj od narednih, odnosno da s leva na desno značaj opada.

 Na ovaj način poređane ključne reči daju bogatije obaveštenje nego sam naslov rada.  

Rezime omogućava da se sa dobijenim rezultatima upozna i svetska javnost. Zato se piše na jednom od svetskih jezika, najčešće engleskom.

                                                       Summary 

Iza rezimea dolazi Summary. 

To je rezime /isti sadržaj i obim/ KVALITETNO  preveden na engleski jezik.

Key words

Key words : prevod ključnih reči na engleski jezik. Jako je važno da prevod bude adekvatan, precizan i kvalitetan.

c.  Uvod

Uvodom treba obuhvatiti: područje projekta, podatke drugih autora koji su poslužili za sopstvena istraživanja ili su bili predmet proveravanja; cilj projekta, odnosno pitanja na koja će rad, odnosno autor/autori odgovoriti.

 On treba da na harmoničan i pristupačan način uvede čitaoce u tekst koji sledi.

Bitan deo uvoda predstavlja i pregled ranijih radova, i projekata.

 Na taj način se ideja rada i cilj istraživanja povezuju sa onim što je ranije rađeno, kako bi čitaocu bilo jasno na čemu se dalje izgrađuje istraživačko saznanje. 

Autor/autori navode radove drugih autora, koje je pročitao i na bilo koji način upotrebio kao polaznu tačku, kao izvor metodike rada, kao objašnjenje neke tehnike itd.

 Literaturu u uvodu navodimo tako što se sagleda šta je do danas urađeno u toj oblasti, šta je sve objašnjeno, odnosno šta bi još trebalo istražiti-kreirati.

Pozivanje na literaturu u tekstu se može se uraditi na dva načina :

0 navodi se prezime autora i broj pod kojim je dotični rad naveden u spisku   literature na kraju rada. Na primer Beljanski [3],

1 navođenjem literaturnog izvora, na pogodnom mestu, samo pomoću zagrade[3]  bez navođenja prezimena autora. 

      
Autor treba dobro da razlikuje način navođenja literature pri pozivanju na  nju u tekstu rada, od načina pri citiranju iste u podnaslovu «Literatura» na kraju rada.

d.  lista simbola

Naslov lista simbola koristi se ako se u radu operiše sa više od 5 simbola

Simbole u listi navesti po abecednom redu, prvo grčka slova, pa brojne oznake, skraćenice, itd. 

Ako u radu ima do 5 simbola-skraćenica, odnosno nije uveden naslov lista simbola, onda to može da se uradi i na mestu gde se prvi put pominje simbol-skraćenica.

e.  alati i metodika rada

Preko ovog poglavlja prikazuje se alati koji su korišćeni, kriterijumi koji su uzeti u obzir prilikom izrade projekta itd.

 Posebno treba prikazati metodiku rada tako da čitalac može da se upozna sa načinom na koji je autor radio istraživanje-projekat. 

To znači da treba definisati sve pojedinosti o korišćenim alatima, tehnikama, metodologiji, kao i postupcima istraživanja-kreiranja, tako da drugi istraživači mogu ponoviti sve opisane postupke i dobiti slične ili indentične rezultate.

 Ne treba opisivati standardne metode, dovoljno je imenovati ih. Nestandardne i složenije postupke treba podrobno opisati.

Za alate treba navesti ključne karakteristike koje su korišćene, kao i definisati zašto je odlučeno da se koristi baš taj alat. Ne treba opisivati detaljno ceo alat, već akcenat dati na ono što je iz tog alata korišćeno. 

f. rezultati istraživanja i diskusija

Najvažniji ujedno i najteži deo rada, sastoji se u interpretaciji dobijenih rezultata. 

U ovom delu treba jasno definisati šta je lični doprinos autora. Ovde treba dati mišljenje o upotrebljivosti projekta, kao i o njegovom potencijalnom daljem razvoju. Takođe treba dati lično mišljenje, uočiti odnose, doneti ocene i sudove, potvrditi ili odbaciti upotrebljivost i vrednost projekta.

Inerpretacija rezultata je najčešće tekstualna, ali sa vrlo sažetim i preciznim ocenam. 

Bitno je da se izostavi razmišljanje o nekom specifičnom rezultatu, već treba saopštiti samo glavne reprezetativne rezultate, a ne sve. 

 Važno je odabrati bitno tj. odvojiti bitno od nebitnog.

U tekstu posebno treba istaći ako će projekat biti negde korišćen, ili se planira da se negde implementira. 

Sve informacije treba iznositi u naučnom, dokumentovano-definisanom stilu. Treba izbegavati apstraktne zaključke i razmišljanja koji nisu bazirani na činjenicama koje proističu direktno iz projekta. 

U diskusiji treba istaći da li se dobijeni rezultatati, kao i opšta razmatranja problema, slažu ili ne slažu sa ranijim rezultazima, mišljenjima ili stavovima drugih autora.

Rezultati istraživanja-projekta mogu biti slični ili različiti sa drugim projektima-istraživanjima. U slučaju da su zapažene ili utvrđene veće razlike, neophodno je istaći u čemu se sastoje. 

Pošteno je da autor rada iznese i one rezultate koji negiraju njegovu hipotezu.  

Na taj način će biti obavešteni i drugi zainteresovani istraživači, te će im se skrenuti pažnja na poteškoće na koje mogu naići, da ih na vreme odklone.

i.  Zaključak

Autor/autori potvrđuje ispravnost primenjenih metoda, ističe važnost dobijenih rezultata projekta i istraživanja i ukazuje na mogućnost daljeg istraživačkograda na istom problemu. Zaključak treba da je koncizan, jezgrovit i precizan. Istaći ono što čini ovaj projekat-istraživanje specifičnim i posebnim.

Ne treba da prelazi deseti deo obima celokupnog rada.






Zahvalnost

(Ukoliko autori smatraju da je potrebno) 

    
Uobičajeno je da se na kraju istraživačkog rada navedu imena svih onih koji su        doprineli i pomogli u njegovoj realizaciji. Svima njima, za savete i pomoć, treba odati zahvalnost.





Literatura


Citirana literatura navodi se prema JUS Z.A1.020-025.

U spisak literature unose se izvori koje je autor koristio u izradi svog rada

( časopisi, knjige, zbornici radova, studije, priručnici, interna dokumenta, statički materijali, internet resursi i sl.). Lista literature se navodi po redosledu pojavljivanja autora u radu uz odgovarajuću numeraciju, arapskim brojevima.

Posebnu pažnju treba obratiti prikazu korišćenje literature koji mora biti bibliografski potpun, tj. čitaocu treba omogućiti da bez većih teškoća pronađe original. Prilikom citiranja veb strana, treba dati prvo informacije koje omogućavaju da se ta strana pronađe na netu, a tek onda konkretna strana. Nikako ne navoditi generičke linkove do glavne strane nekog sajta, već isključivo na konkretnu stranu na kojoj je tražena informacija. 

 Sam način pisanja treba da bude jednoobrazan onako kako to zahtevaju redakcije izdavača. Iz tih razloga prikazaćemo šemu sa primerom za citiranje časopisa, knjiga i zbornika radova.

Kada je literaturni izvor knjiga: redni broj literature, inicijal imena i prezime prvog autora, zatim inicijal imena i prezime drugog i ostalih autora, naslov knjige, izdavač, mesto izdavanja i godina izdanja.

Na primer:

[1.] C.N.R. RAV, Ultraviolet and Visible Spectroscopy, Butter works, London, 2 nd. ed., 1967


Kada je literaturni izvor Zbornik radova sa naučnog ili stručnog skupa (kongres, simpozijum, savetovanje): redni broj literature, inicijal imena i prezime prvog autora, zatim inicijal imena i prezime drugog i ostalih autora, naslov rada, naziv publikacije sa skupa (poželjno je organizator skupa), mesto i godina održavanje, broj početne stranice.

Na primer:

[1.] T. LJ. Đaković – Sekulić, N. U. Perišić – Janjić, S. D. Petrović, The retenrion behaviour of some amides on various supports, “Instrumental Planar Chromatography”, Interlaken, 1997, 79.


Kada je literaturni izvor internet strana ili dokumenti dostupni samo na internetu. U radovima koji se bave savremenim informacionim tehnologijama najviše resursa se nalazi na internetu ali treba voditi računa kako se citiraju ovi resursi. Pravilno citiranje bi bilo:

[1.] Proizvođač: Atmel, Mikrokontroler (datasheet): AT89S52,  (http://www.keil.com/dd/docs/datashts/atmel/at89s52_ds.pdf)


Napomena: Pri citiranju u navedenim primerima treba uočiti znake interpunkcije i da se za naziv časopisa, knjige, zbornika, koriste slova iz fonta Italic veličine 10pt Normal kao i da se broj izdanja (volume) bolduje.


Za drugu citiranu literaturu (patenti, referati, izveštaji i sl.) treba navesti što potpunije podatke na osnovu kojih se mogu naći, kao i broj stranica tog materijala.


U spisak literature ne treba stavljati literaturne izvore na koje se autor ne poziva u tekstu.


Poželjno je koristiti autentično pismo i jezik za odgovarajuće literaturne izvore, (računarska tehnika to omogućuje) ili izvršiti transkripciju. Na primer, ruski literaturni izvor treba pisati ćirilično ruskim pismom.

b) Tehnička obrada rezultata istraživačkog rada
Ništa manje nije bez značaja tehnička obrada rukopisa rada koja pored kucanja teksta obuhvata i ilustrovanje rezultata pomoću tabela, grafikona, slika, jednačina, formula i sl.


Radi ujednačavanja tehničke obrade istraživačkih radova, za sve učesnike na Smotri, neophodno je pridržavati se sledećeg uputstva koje se generalno odnosi na istraživački rad i njegovu strukturu:
· Obim otkucanog rada sa svim prilozima i crtežima iznosi  do 12 stranica,

· Tekst rada se realizuje na računaru korišćenjem Word-a  i štampa na listovima A4 formata pomoću laserskog štampača. 

Slova su ćirilična ili latinična. Tekst rada se kuca slovima veličine 12 pt Normal u fontu Times New Roman sa proredom 1,5. Spisak citirane literature se kuca sa slovima veličine 10pt B u fontovima Times new Roman i Italic sa istim proredom. Margine za tekst su: leva i desna 2,5 cm, gornja 2 cm (sem na prvoj strani koja je 5 cm) i donja 2,5 cm.

· Naslov rada se piše velikim slovima veličine 14 pt B,

· Imena autora i mentora se pišu velikim slovima veličine 12 pt B,

· Razred, godina studija, naziv Centra se piše sa malim slovima veličine 12 pt N,

· Podaci o mentoru (zvanje, mesto zaposlenja ) se pišu malim slovima veličine 12 pt N,

· Podnaslovi u radu su ustvari naslovi poglavlja koji obuhvataju: rezime, uvod, listu simbola, alata i metodiku rada, rezultate istraživanja i diskusiju, zaključak i citiranu literaturu. Ovi podnaslovi se pišu velikim slovima 12pt B, centrirano,

· Sporedni podnaslovi, u okviru pojedninih poglavlja kucaju se malim iskošenim slovima Italic, veličine 12ptN,

· Za nazive tabela koriste se kosa slova Italic veličine 10pt N,

· Za podatke u tabeli koriste se slova veličine 10pt N.
Tabele treba postaviti na odgovarajuće mesto u tekstu rada tako da prikazani rezultati prate tekst. Tabele označiti arapskim brojevima po redu (Tabela 1, .....) sa nazivom tabele na srpskom i engleskom jeziku. Npr. 

Tabela 2. Rf - vrednosti ispitivanih supstanci

Table 2.   Rf - values of investigated compounds

· Za potpise ispod slika koristiti kosa slova Italic veličine 10pt N.

Slike, crteži, dijagrami, ...... se smatraju tekstom i ulaze u dozvoljen obim rada do 12 kucanih stranica. U tekstu se označavaju arapskim brojevima po redu (sl. 1, sl. 2, ...) sa potpisom na srpskom i engleskom jeziku. Crteže i dijagrame treba uraditi na računaru korišćenjem AutoCAD,  photoshop, Corel draw programa ili na pausu tušem pa ih skenirati i postaviti na odgovarajuće mesto u radu. Isto postupiti i sa fotografijama.

Na primer: sl. 1 – Naziv slike 

· Jednačine i formule treba kucati u posebnom redu uz korišćenje optimalnih fontova. Redni broj jednačine se daje u maloj zagradi uz desnu marginu,

· Grčka slova se pišu pravo,

· Promenljive se pišu (italik),

· Funkcije (log, sin,j, e) se pišu pravo,

· Matrice i vektori se pišu bold i italik.

I       Istorijat računarstva
1. Fransucki filozof, književnik, matematičar i fizičar Blez Paskal je napravio oko 50-tak mehaničkih modela mašina za objavljanje jednostavnih matematičkih operacija, preteče savremenih računarskih mašina. U kom veku je živeo ovaj francuski naučnik?

a. XVI

b. XVII

c. XVIII

d. XIX
2. Mašinu za računanje “Paskalina” je konstruisao?

a. Charles Xavier Thomas.

b. Blaise Pascal.

c. Alan M Turing.

d. Grejs Hoper
3. Pomagalo za pamćenje brojeva pomoću kanapa se zvalo?

a. Quipu

b. Abakus

c. Paskalina
4. U kojoj tehnologiji su proizvedeni računari prve generacije:

a. Tranzistori

b. Elektronske cevi

c. Integrisana kola

d. Visoko-integrisana kola
5. Prvi uspešno konstruisan računar je bio:

a. ABC 

b. ENIAC

c. Blue Gene

d. EDVAC
6. Brzina promena tehnologija u oblasti hardvera može da se opiše Moor-ovim zakonom, koji kaže da se kapacitet računara povećava dva puta svakih:

a. 18 meseca

b. 12 meseca

c. 3 meseca

d. 6 meseca

e. 36 meseca
7. IBM-ov PC računar iz 1981 godine je koristio operativni sistem:

a. MS DOS

b. Windows

c. CP/M

d. BIOS

e. QDOS
II  Arhitektura računara

1. SIMM, DIMM, DDR i DDR2 su različiti tipovi čega?

a. Memorije koja se ugrađuje u prenosne uređaje

b. Blokova RAM memorije.

c. HDD-a

d. Blokova ROM memorije.
2. Glavni nedostatk Hard Diska u odnosu na RAM Memorjiu

a. Kapacitet

b. Brzina pristupa

c. Fizička veličina
3. RAM je skraćenica od

a. Read Access Memory

b. Random Access Memory

c. Read Advance Memory

d. Read Adaptive Memory
4. ROM je skraćenica od?

a. Random Optimal Mask

b. Read Only Memory

c. Random Only Magnet

d. Regulating Optimal Memory
5. Vrsta memorije iz koje se podaci mogu samo čitati je:

a. ROM

b. EPROM

c. RAM
6. Skraćenica DDR3 označva?

a. Double Date Rate 

b. Double Disk Rate

c. Direct Disk Read

7. U koju vrstu memorija se svrstava page fajl?

a. radna memorija

b. keš memrija

c. virtualna memorija

d. spoljašnja memorija

8. Memorija je deo računar koji:

a. Služi za trajno čuvanje procesiranih podataka

b. Upravlja radom računara

c. Služi za privremeno čuvanje procesiranih podataka
9. U koju vrstu memorija se svrstava BlueRay Disk?

a. radna memorija

b. keš memrija

c. virtualna memorija

d. spoljašnja memorija
10. Spoljne memorije spadaju u klasu:

a. ulazno-izlaznih uređaja

b. memorija koje čuvaju podatke samo dok ima napajanja

c. ROM memorija

d. RAM memorija

e. EPROM memorija
11. Spoljne memorije su one memorije:

a. Kojima se pristupa preko ulazno-izlaznih kanala (magistrala)

b. Koje se nalaze van kucišta racunara

c. Koje se nalaze van procesora

d. Koje se nalaze na drugim racunarima

e. Kojima se pristupa preko sistemske magistrale.
12. Podaci na R-CD ROM diskovima se:

a. Ne mogu brisati

b. Mogu brisati neograniceno puta

c. Mogu brisati više puta

d. Mogu brisati samo jednom

e. Mogu brisati do 10000 puta
f. Skracenica ROM oznacava memorije koje imaju sledecu karakteristiku:

g. Cuvaju sadržaj i kad nema napajanja

h. Cuvaju sadržaj ako ima napajanja uz osvežavanje svake milisekunde

i. Cuvaju sadržaj ako ima napajanja

j. Cuvaju sadržaj ako ima napajanja uz povremeno osvežavanje

k. Cuvaju sadržaj i kad nema napajanja uz povremeno osvežavanje
13. Dinamicke memorije (DRAM) cuvaju sadržaj:

a. samo dok ima napajanja strujom, ali je potrebno obnavljati sadržaj

b. i kad nema napajanja strujom ali je potrebno obnavljati sadržaj

c. samo dok ima napajanja strujom

d. i kada nema napajanja

e. nezavisno od napajanja
14. Statičke memorije (SRAM) čuvaju sadržaj:

a. samo dok ima napajanja strujom  

b. i kad nema napajanja strujom ali je potrebno obnavljati sadržaj  

c. i kada nema napajanja  

d. nezavisno od napajanja  

e. samo dok ima napajanja strujom, ali je potrebno obnavljati sadržaj
15. U koju vrstu memorija se svrstava DVD?

a. radna memorija

b. keš memrija

c. virtualna memorija

d. spoljašnja memorija
16. Kapacitet DVD diskova je

a. veci od 4 GB

b. između 256 i 700 MB

c. između 700 i 1024 MB

d. 700 MB

e. manji od 256 MB
17. Koji od navedenih medijuma ima naveći kapacitet?

a. Flopy Disk

b. BD

c. DVD

d. CD
18. Na koji IRQ se obično mapira LPT1 port:

a. 3

b. 5

c. 7

d. 9
19. Rezolucija za HD od 1080p iznosi?

a. 1280x720

b. 1920x1080

c. 1600x1200
20. Rezolucija koja se obično označava kao HD ready?

a. 1366x768

b. 1920x1080

c. 800x600

21. Film u HD 1080p formatu može da se smesti na koji medijum?

a. Blu Ray Disk

b. DVD

c. CD
22. Ako se za opis boje jedne tačke digitalne fotografije koriste tri bajta, onda se na fotografiji može razaznati:

a. Preko 16 miliona boja 

b. 256 boja  

c. 8 boja  

d. 64635 boja  

e. 16 boja
23. Koliko bitova ima jedan bajt

a. 4

b. 8

c. 16

d. 32

e. 64
24. Koliko bajtova ima 512 bitova
a. 8

b. 32

c. 64

d. 128

e. 256

f. 512

g. 1024

25. Koliko bajtova ima 1 MB?

a. 1.000.000

b. 1.048.576

c. 1.000.024

d. 1.024.024
26. 1 GB sadrži kolko Bajtova

a. 1073741824B

b. 1024B

c. 8B
27. Decimalna vrednost heksadecimalnog broja 10F je

a. 271

b. 115

c. 60

d. 121

e. 341
28. Decimalna vrednost heksadecimalnog broja 0AF je

a. 175

b. 215

c. 602

d. 341

e. 121
29. Decimalna vrednost binarnoh broja 101001 je

a. 41

b. 60

c. 3

d. 115

e. 12
30. Decimalna vrednost binarnog broja 011001 je

a. 25

b. 12

c. 3

d. 115

e. 60
31. Decimalna vrednost binarnog broja 001001 je

a. 9

b. 12

c. 115

d. 60

e. 3

32. Decimalna vrednost heksadecimalnog broja 101 je

a. 257  

b. 34  

c. 115  

d. 12  

e. 60 
33. Koja je osnova trinarnog brojnog sistema?

a. 3

b. 2

c. 0

d. 10

e. 8
34. Koja je osnova decimalnog brojnog sistema?

a. 10

b. 8

c. 2

d. 1

e. 0
35. Koja je osnova binarnog brojnog sistema?

a. 10  

b. 0  

c. 2  

d. 16  

e. 8 
36. Šta je bit?

a. Jedna binarna cifra

b. Niz od osam bajtova

c. Niz od osam binarnih cifara

d. Memorijski prostor dovoljan za memorisanje jednog karaktera

e. Jedna heksadecimalna cifra
37. Brzina rada memorije se meri u?

a. GHz

b. FLIPS

c. MIPS
38. Brzina rada procesora se meri u?

a. GHz

b. FLIPS

c. MIPS

39. Procesor sa oznakom Q6600 je proizveden od strane kog proizvođača?

a. Cyrix

b. AMD

c. Intel
40. Koji od navedenih procesora nije napravljen u AMD kompaniji?

a. Celeron

b. Opteron

c. Phenom

d. Athlon
41. Procesor E6700 pripada kojoj seriji procesora?

a. AMD Athlon

b. Quadro Core

c. Core2Duo 

d. CoreSolo

e. Koji od navedenih uređaja jeste ulazni uređaj?

f. Monitor

g. Štampač

h. Game pad
42. Procesor sa oznakom Q6600 koliko ima jezgara?

a. 1

b. 2

c. 4

d. 8
43. U koju od navedenih kategorija spada procesor Intel Dual Core 2

a. 32 bitni, dvojezgarni

b. 64 bitni, dvojezgarni

c. 128 bitni, dvojezgarni
44. Oznaka GeForce 8800GT označava koji deo u kompjuteru?

a. Matičnu ploču

b. HDD

c. Grafičku karticu

d. Procesor
45. Matrični, laserski i kapljični (ink-jet) su vrste?

a. Skenera

b. Štampača

c. Kamera
46. Kada se kaže da je rezolucija štampača 600x600, onda to znači da se toliko tačaka može odštampati na:
a. Jednoj strani
b. Jednom kvadratnom milimetru
c. Jednom kvadratnom centimetru
d. Jednom kvadratnom inču
47. Matrični štampači formiraju otisak:

a. udarom iglica na traku sa mastilom  

b. prenosom boje sa unapred pripremljene matrice  

c. nagorevanjem termičkog papira  

d. izbacivanjem kapljica mastila  

e. raspoređivanjem grafitnog praha  
48. Matrični štampači spadaju u klasu:

a. štampača sa udarom 

b. laserskih štampača  

c. TFT štampača  

d. termičkih štampača  

e. ink-jet štampača  
49. Ink-jet štampači formiraju otisak:

a. izbacivanjem kapljica mastila  

b. udarom iglica na traku sa mastilom  

c. prenosom boje sa unapred pripremljene matrice  

d. nagorevanjem termičkog papira  

e. raspoređivanjem grafitnog praha
50. Ako je štampač vezan na paralelni port računara, prilikom instalacije štampača u dijalogu biramo sledeći port:

a. COM1

b. COM2

c. File

d. LPT1
51. Koji od navedenih portova na računaru nije seriski?

a. COM

b. LPT

c. USB
52. Podaci u memoriji se beleže pomoću?

a. Nula i jedinica (ima napona, nema napona)

b. Različitim nivoim napona struje (drukčiji napon za svaku vrednost koja se beleži)

c. Kvantnim stanjima atoma silicijuma u memoriskom modulu
53. Koja od navedenih rezolucija odgovara širokom ekranu?

a. 1440x900

b. 1024x768

c. 800x600
54. TFT (thin film transistor) tehnologija se koristi za proizvodnju:

a. Displeja 

b. Čvrstih diskova  

c. Procesora  

d. Memorija  

e. Magistrala 
55. PCI Express magistrala može da ima:

a. 1, 2, 4, 8, 16 ili 32 linije  

b. Samo 8 linija  

c. Samo 2 linije  

d. Samo 16 linija  

e. Samo 4 linije
56. GPU je?

a. Glavni Procesor

b. Čip na matičnoj ploči

c. Procesor na grafičkoj karti
57. U koju vrstu memorija se svrstava BlueRay?

a. radna memorija

b. keš memrija

c. virtualna memorija

d. spoljašnja memorija
58. Brzina protoka podatak se meri u?

a. Bitovima po sekundi

b. Bitovima

c. Bajtovima po sekundi

d. Bajtovima
59. Protok podataka kroz modem se meri u?

a. bit/sec

b. byte/sec

c. clikc/sec

d. T/s
60. Oznaka na modemima 56kbps znači

a. 56 kilo bita u sekundi

b. 56 kilo bajta u sekundi

c. 56 kikova brojaca po sekundi

d. Ovo ništa ne znači
61. Sa protokom od 56 kbps za jednu sekundu možemo da dovučemo koliko podataka

a. 7 kB

b. 5,6 kB

c. 56kB

d. 1MB
62. WiMax predstavlja?

a. Način prenošenja podataka putem telefonskog kabla

b. Način prenošenja podataka putem mrežnog kabla

c. Način prenošenja podataka putem radio talasa
63. Da li kontoler za Wii konzolu može da se poveže na Windows i kako?

a. Ne može da se poveže on je pravljen isključivo za Wii konzolu

b. Može preko USB kabla

c. Može preko Bluetooth

d. Preko COM porta

64. Ulazni uređaji računara su

a. tastatura, miš i džojstik

b. ekran i tastatura

c. Ekran, tastatura i miš

d. Ekran i štampač
65. Procesor  i3 je napravila kompanija?

a. Apple

b. IBM

c. Intel

d. AMD

66. PC486 generacija računara ima spoljni koprocesor?

a. DA

b. NE
67.  Apple računar pod nazivom iPad ima koji procesor?

a. A4

b. i3

c. X2

d. G4

68. Cifre binarnog brojnog sistema su:

a. 0 i 2

b. 0, 1 i 2

c. 0 i 1

69. Cifre oktalnog brojnog sistema su:

a. 0,1,2,3,4

b. 0,1,2,3

c. 0,1,2,3,4,5,6,7

70. CPU je deo računar koji:

a. Služi za trajno čuvanje procesiranih podataka

b. Upravlja radom računara

c. Služi za privremeno čuvanje procesiranih podataka

III  Operativni sistemi


- Windows (istorijat, delovi, arhitektura, apps)


- Linux (istorijat, delovi, ahritektura, apps)


- Mac OS X (istorijat, delovi, arhitktura, apps)

1. Operativni sistem spada u grupu:

a. Sistemskih programa  

b. Uslužnih programa  

c. Programa za akviziciju i upravljanje  

d. Pomoćnih programa  

e. Aplikativnih programa
2. U hijerarhijskom modelu operativnog sistema najniži sloj se naziva 

a. Low level system 

b. Base 

c. Jezgro 

d. Interfejs 

e. mašinski kod
3. Iz Windows Explorera mogu da se kreće kroz sledeće 

a. Samo kroz podatke na lokalnom disku

b. Kroz podatke na lokalnom disku i na spoljnjim diskovima

c. Kroz podatke na lokalnom disku, na spoljnjim diskovima, i kroz lokalnu mrežu

d. Kroz podatke na lokalnom disku, na spoljnjim diskovima, kroz lokalnu mrežu, i na internet
e. Windows Explorer je sistemski program koji se koristi za

f. Pretraživanje Interneta

g. Kreiranje i brisanje prečica programa

h. Upravljanje podacima sa spoljašnih memorija računara
4. Na Windows-u opcija “Save as...” ćemo naći u stavci menija

a. Edit

b. Help

c. View

d. File
5. Da li je moguće notpad da se isključi, da ne bude instalran na Windows operativnom sistemu.

a. Ne

b. Da
6. Koji od navedenih kodnih rasporeda predstavlja tipičnu univerzalnu implementaciju Unicode kodnog rasporeda

a. CP1250

b. CP1251

c. UTF-8

d. ISO-8859-1
7. Koji od navedenih kodnih rasporeda može da prikaže i latinicu i ćirilicu istovremeno?

a. CP1250

b. CP1251

c. UTF-8 

d. ISO-8859-1

8. UNICODE kodira:

a. karaktere

b. bajtove

c. glifove

d. heksadecimalne brojeve

e. binarne brojeve
9. Koji od navedenih kodnih rasporeda predstavlja srpsku latinicu u windowsu?

a. CP1250

b. CP1251

c. UTF-8

d. ISO-8859-1
10. Šta su to Unicode fontovi

a. Bilo koji font koji ima naša latinična slova

b. Bilo koji font koji ima naša ćirilična slova

c. Fontovi koji nemaju naša slova

d. Fontovi koji u sebi sadrže skoro sve simbole svih jezika uključujući i našu latinicu i ćirilicu
11. Da li količina instaliranih fontova utiče na performanse Windows operativnog sistema

a. Da

b. Ne
12. Oznaka SR u taskbaru za tastaturu označava?

a. Srpsku latiničnu tastaturu

b. Srpsku ćiriličnu tastaturu

c. Ista je oznaka i za srpsku latiničnu i za srpsku ćiriličnu

d. Sr je oznaka za Sirijsku tastaturu
13. Da li se razlikuje raspored tastera na Srpskoj i Engleskoj tastaturi?

a. Da

b. Ne

c. Zavisi od proizvođača

14. Čemu služi OLE objekat

a. Služi za vizuelnu raspodelu komponenti

b. Služi za povezivanje programa sa bazom podataka

c. Služi za čuvanje podataka iz drugih aplikacija

d. Služi za definisanje programske strukture
15. Na Windows operativnom sistemu opcija “New” ćemo naći u stavci menija

a. Edit

b. Help

c. View

d. File
16. Na Windows operativnom sistemu opcija „Find“ se nalazi u kojoj stavci menija?

a. File

b. Select

c. Edit

d. Help

17. Na Windows operativnom sistemu opcija „Cut“ se nalazi u kojoj stavci menija?

a. File

b. Select

c. Edit

d. Help
18. Na Windows operativnom sistemu opcija „Open” ćemo naći u stavci menija

a. Edit

b. Help

c. View

d. File
19. U okviru menija EDIT obično se nalaze komande:

a. Cut, Copy i Paste

b. New, Open i Close

c. Font i Paragraph
20. Koja prečica na tastaturi je za @ kada je podešena Srpska tastatura?

a. Shift + 2

b. Alt Gr + V

c. Ctrl + Shift + A

d. Nije moguće dobiti oznaku “@” ni jednom kombinacijom tastera.
21. Koja prečica na tastaturi je za [ kada je podešena Srpska tastatura?

a. Alt + Š

b. Alt Gr + F

c. Ctrl + Shift + Š

d. Nije moguće dobiti oznaku “[” ni jednom kombinacijom tastera.

22. Ako je na računaru sa Windose OS-om podešena Srpska tastatura, kako može da se otkuca “{“

a. Ctrl + Alt + Š

b. Alt Gr + B

c. Ctrl + Shift + Alt + Š

d. Nije moguće dobiti oznaku “{” ni jednom kombinacijom tastera na srpskoj tastaturi.
23. Ako je na računaru sa Windose OS-om podešena Srpska tastatura, kako može da se otkuca “\“

a. Ctrl + Alt + \

b. Alt Gr + W

c. Ctrl + Alt + Š

d. Nije moguće dobiti oznaku “\” ni jednom kombinacijom tastera na srpskoj tastaturi.
24. Koja prečica na Windowsu na tastaturi je za € kada je podešena Srpska tastatura?

a. Ctrl + Alt + E

b. Alt Gr + E

c. Ctrl + Shift + Alt + E

d. Nije moguće dobiti oznaku “€” ni jednom kombinacijom tastera.
25. Windows Vista ima grafičko okruženje koje se zove?

a. Gnome

b. Aero

c. Windows

d. KDE
26. Koji od navedenih nije grafičko okruženje Linux operativnog sistema?

a. KDE

b. Gnome

c. XFCE

d. Aero
27. Koje godine se pojavio prvi grafički operativni sistem?

a. 1984

b. 1988

c. 1990

d. 1994

28. Proizvođač opretivnog sistema Windows je:

a. DOS 

b. Intel

c. Microsoft

d. IBM
29. U Control Panel-u koja ikona je zadužena za menjanje slike na ekranu?

a. Regional Settings

b. Desktop Themes

c. Multimedia

d. Display

30. Promena tastature na srpsku se podešava u okviru Control-Panela izborom opcije:

a. Regional Settings 

b. Display 

c. System

d. Printers
31. Koja opcija se bira ako je potrebno poredjati datoteke u My Computer po datumu poslednje izmene:

a. View->Arrange Icons by -> Size
b. View->Arrange Icons by -> Name

c. View->Details
d. View->Arrange Icons by -> Modified
32. Prilikom odabira vremenske zone, za našu zemlju biramo?

a. GTM-2

b. GTM-1

c. GTM

d. GTM+1

e. GTM+2

33. Attribut Hidden, označava da datoteka:

a. Može samo da se čita

b. Skrivena je pa ne može da se vidi pri listanju

c. Može samo da se menja

d. Prebačena je u Recycle Bin
34. Osnovni format za zapis slika u programu Paint u Windows 7 je?

a. png

b. jpg

c. bmp
35. Office 2011 je Microsoftov proizvod namenjen?

a. Microsoft Vista operativnom sistemu

b. Microsoft Windows 7 operativnom sistemu

c. Linux Ubuntu 9.04 operativnom sistemu

d. Mac OS X operativnom sistemu

e. Microsoft ne poseduje proizod Office 2011
f. Preko COM porta

36. Format zapisa fajla u Word 2010 ima extenziju?

a. doc

b. *.docx

c. *.odt

d. *.xml

37. Koje od ovih aplikacija se isporučuju sa operativnim sistemom Windows

a. WordPad, Paint, Imaging

b. Word, Paint, Notpad

c. Notpad, Paint, WinCommander

d. Photoshop, Word, CorelDraw
38. Pomoć u svakom programu može da se dobije odabirom:

a. F1 (tasterom)

b. Help (tasterom)

c. Any (tasterom)

d. Ctrl + H (kombinacijom tastera)
39. Na Windows operativnom sistemu kada se prevlači ikona sa jednog prozora na drugi a oba prozora pripadaju istom fizičkom disku, podrazumevana operacija je?

a. Copy

b. Move

c. Paste

d. Create Shortcuts Here
40. Clipboard ima veze sa sledećim operacijama:

a. Cut, Copy i Paste

b. Cut i Delete

c. Print i Print preview
41. Na Windows operativnom sistemu Ako su nam ikone i tekst suviše sitni potrebno je?

a. Povećati rezoluciju ekrana

b. Smanjiti rezoluciju ekrana

c. Promena rezolucije ekrana neće uticati na veličinu teksta i ikona.
42. Program za obradu teksta koji dolazi u sklopu Windowsa je:

a. Word

b. WordPad

c. Outlook
43. Šta od navedenog nije OS?

a. Wine

b. Mint

c. Slax
44. Ubuntu distribucija Linuxa je nastala od koje distribucije?

a. Debian

b. RedHat

c. Suse

d. Slackware
45. Od sledećih imena samo jedno je ime operativnog sistema:

a. Mac OS X

b. AMD

c. Internet Explorer

d. Intel

e. Apple
46. Od sledecih imena samo jedno je ime operativnog sistema:

a. Linux

b. Internet Explorer

c. OpenOffice

d. Intel

e. Word
47. Operativni sistem Linux se koristi 

a. Za personalne (PC) racunare i servere

b. Samo za veb servere

c. Samo za servere

d. Samo za veb servere i mail servere

e. Samo za personalne (PC) racunare
Komandna linija
Upravljanje operativnim sistemom može da se sprovede na više različitih načina. Najuobičajenije je da se koriste razni alati specijalno napravljeni u tu svrhu, međutim, ako želimo da zaista znamo kako da upravljamo operativim sistemom i njegovim mogućnostima i delovima neophodno je da naučimo kako možemo direktno da pristupimo tim opcijama iz komandne linije, bez upotrebe alata. 

Komandna linija je način da se obave operacije na operativnom sistemu zadavanjem odgovarajućih naredbi i prosleđivanjem parametara tim naredbama. Interfejs komandne linije (CLI) je mehanizam za interakciju sa operativnim sistemom ili nekim drugim softverom računara uz pomoću niza tekstualnih naredbi. Ona takođe omogućava jednostavno udaljeno upravljanje operativnim sistemom, bez potrebe za složenom komunikacijuom (prikazivanje grafičkog okruženja jednog sistema na drugom). 
DOS
Windows operativni sistem je evoluirao od DOS operativnog sistema koji se zasnivao na naredbama komandne linije. Osnovne operacije operativnog sistem su se izdavale isključivo putem komandne linije. Sve aplikacije koje su rađene za DOS su imale odgovarajuće narebe koje su mogle da se pozovu iz komandne linije. Nakon što je kreirano grafičko okruženje (Windows 95), mnoge komande DOS-a su izbačene ili zamenjene. Korisnici su u velikoj većini izbacili upotrebu komandne linije u novijim Windows desktop rešenjima. Međutim potreba za razvijenim i bogatim skupom opcija u komandnoj lijniji je i dalje prisutna pogotovo u serverskim verzijama. Iz tog razloga je u nekim novijim serverskim verzijama operativnog sistem dodat veliki broj novih naredbi I mogućnosti, pa čak i unapređen način rada sa komandnom linijom. Noviji Windows operativni sistemi poput Windows 7 vraćaju moć komandnoj liniji, mada u odnosu na Unix-olike operativne sisteme Windows operativni sistem imaju značajno slabije razvijenu komandnu liniju, odnosno manje mogućnosti upravljanja operativnim sistemom kroz komandnu liniju.
Windows PowerShell

PowerShell je jedna od najmoćnijih administratorskih alatki. Takozvana buduća zamena za command prompt. Baziran je na CL okruženju a izgrađen na .NET tehnologiji. Predstavljen je kao alternative za script i batch zadatke. PowerShell podržava sve operativne sisteme, skripte i CL bazirane alate. 

Posle pojave PowerShell-a sve se može napraviti preko komandne linije. Veoma je zanimljivo i to da jednostavna komanda PowerShell-a često zamenjuje stranice VB koda. Dosta je jednostavnija sintaksa. Exchange SystemManager inače u pozadini izvršava PowerShell komande, i time je rešen problem rada sa skriptama u Windows okruženju. Stvari koje nije bilo moguće napraviti iz komandne linije sada je moguće napraviti. Nema više problema oko VBScripta koji je ranije zahtevao znanje programiranja, znanje Visual Basic-a, WMI-a, WBEM-a, ADSI-a, objektnih modela… Naravno i rešen je problem sigurnosti.

Linux shell
Linux operativni sistemi imaju najrazvijeniji skup naredbi za upravljanje operativnim sistemom iz komandne linije. Uz to moguće je pokrenuti operativni sistem i bez grafičkog okruženja i sve u njemu obavljati isključivo pomoću naredbi komandne linije i/ili pomoću napisanih skripti. Ovo je vrlo čest slučaj sa serverskim verzijama ovog operativnog sistema. Mnoge serverske verzije Linux operativnog sistema se i isporučuju bez grafičkog okruženja. Linux je moguće startovati i sa takozvanog Live CD-a pa onda experimentisati sa upravljanjem nad operativnim sistemom bez narušavanja bojazni da će originalni operativni sistem računara biti ugrožen

Ovom segmentu se nalaze pitanja vezana za naredbe komandne linije dos-a, power shell-a i linux-a. 

1. Kako sadržinu diska C kopiramo na disk D pomoću DOS naredbe DISKCOPY:

a. DISKCOPY C:D

b. DISKCOPY D:C

c. DISKCOPY C D

d. DISKCOPY D C

e. Ovu naredbu ne treba koristiti ni zašta drugo osim za kopiranja disketa.
2. Koja od prikazanih DOS komandi kreira list.txt fajl i puni ga sa spiskom fajlova iz tekućeg direktorijuma?

a. DIR list.txt

b. DIR /f list.txt

c. DIR > list.txt

d. Nije moguće ispisati sadržaj direktorijuma u fajl iz DOS naredbe DIR.
3. Kako se formatira disk D iz dosa?

a. format C:

b. format D:

c. f / D

d. format D
4. Pomoću koje naredbe iz DOS-a može da se prikažu svi xml dokumenti u tekućem direktorijumu?

a. Dir xml

b. dir where doc=xml

c. dir *.xml

d. dir extension=xml

5. Pomoću koje naredbe iz DOS-a može da se prikažu svi css dokumenti u tekućem direktorijumu?

a. Dir css

b. dir where doc=css

c. dir *.css

d. dir extension=css
6. Kopiranje podataka iz jednog foldera u drugi se vrši pomoću naredbe:

a. CP C:\folder\file1.ext c:\folder2

b. COPY C:\folder\file1.ext c:\folder2 

c. CP C:\folder\file1.ext c:\folder2\file1.ext

d. COPY C:\folder\file1.ext c:\folder2\file1ext 

e. CP C:\folder\file1.ext c:\folder2\file2.ext

7. Dos naredba tree radi sledeće:

a. Izlistavanje i pregled direktorijuma sa poddirektorijumima

b. Pravljvenje drveta direktorijuma

c. Smeštanje direktorijuma u poddirektorijum.
8. Pomoću koje dos naredbe se prazni ekran komandnog prompta?

a. Clear

b. CLS

c. EMPTY
9. U osnovne komande DOS-a ne spada:

a. New Folder

b. DIR

c. COPY

d. CD
10. Komanda DEL:

a. Daje pregled podataka o datotekama

b. Primema disketa ili disk za rad

c. Briše datoteke

11. Koliko memorije je mogao da adresira DOS operativni sistem?

a. 1MB

b. 2GB

c. 640kB

d. Neograničeno
Korišćenje aplikacija (Word, Excel, Corel)
1. Kombinacija tastera u Wordu Ctrl + H označava

a. Find...

b. Replace...

c. Go to...

d. Hide...
2. Ako želimo u Wordu da selektujemo samo jednu rečenicu to možemo uraditi na sledeći način

a. Kliknuti 3 puta mišem negde u rečenici. 

b. Kliknuti jednom mišem negde u rečenici dok je pritisnut Ctrl taster.

c. Kliknuti dva puta mišem negde u rečenici dok je pritisnut Ctrl taster.

d. Pozicionirati se ne početak rečenice i pritisnuti strelicu na desno dok držimo Ctrl, i Alt taster.
3. Kada se u Word-u pokazivač miša nalazi na levoj ivici papira, tada se jednim klikom na levi taster miša selektuje:

a. Ceo tekst

b. Jedna rečenica

c. Jedan red

d. Jedan pasus
4. Ako želite da u Word-u pretvorite sva slova u odgovarajuća velika slova onda ćete, selektovati taj deo teksta pa:

a. Birate Edit->ToUpper

b. Birate Edit->All Caps

c. Birati View->All Caps

d. Birate Format->Font, pa potvrdite opciju All caps
5. Ako je neki deo teksta “italik” to znači da je on:

a. Metalne boje

b. Iskošen

c. Podebljan
6. Ako je neki deo teksta “bold” to znači da je on:

a. Metalne boje

b. Iskošen

c. Podebljan
7. Najpoznatiji program za obradu tabelarnih podataka je:

a. Word

b. Excel

c. Corel Draw
8. Pri kucanju teksta u Word-u, taster Enter se koristi za:

a. Prelazak u novi red

b. Prelazak u novi pasus

c. Prelazak na novu stranu
9. U programu Word pomoću koje kombinacije tastera može da se selektuje tekst od trenutnog položaja do kraja dokumenta

a. Ctrl + PgDown

b. Ctrl + Alt + Down

c. Ctrl + Shift + End

d. Ctrl + End
10. Ako želimo u Wordu da selektujemo samo jednu reč to možemo uraditi na sledeći način

a. Kliknuti 3 puta mišem negde u reči. 

b. Kliknuti jednom mišem negde u reči dok je pritisnut Ctrl taster.

c. Kliknuti dva puta mišem negde u reči.
11. Ako u programu MS Word se aktivira kombinacija tastera Alt + I šta će se desiti?

a. Aktiviraće se dijalog Insert

b. Ispisaće se veliko slovo I 

c. Aktiviraće se meni Insert

d. Ništa se neće dogoditi
12. U programu Word pomoću koje kombinacije tastera može da se selektuje tekst od trenutnog položaja do kraja reda

a. Shift + PgDown

b. Shift + Alt + Down

c. Ctrl + Shift + End

d. Shift + End
13. Kojom kombinaciom tastera u Wordu možemo da selektujemo kompletan dokument?

a. Ctrl + D

b. Alt + D

c. AltGr + A

d. Ctrl + A
14. Ruler u Wordu može da pokazuje u inčima ili u mm od čega to zavisi?

a. Od podešavanja Windows sistema

b. Od podešavanja prilikom instalacije Worda.

c. Od podešavanja Worda.

d. Od podešavanja tekućeg dokumenta.

15. U Wordu opcija “New” označava

a. Kreiranje novog dokumenta, pri čemu postojeći ostaje prisutan i ne promenjen

b. Kreiranje novog dokumenta, pri čemu se postojeći automatski snima i gasi.

c. Kreiranje novog dokumenta, pri čemu se postojeći samo gasi bez snimanja.

d. Kreiranje novog dokumenta, pri čemu se korisniku postavlja pitanje šta da radi sa postojećim dokumentom.

16. Brisanje reda u Wordovoj tabeli se radi na sledeći način (zaokružiti sve tačne odgovore)

a. Selektovati ga iz menija edit odabrati Delete, u prozoru delite odabrati dugme entire row

b. Učiniti aktivnim ćeliju iz menija edit odabrati Delete, u prozoru delite odabrati dugme entire row

c. Selektovati red i kliknuti na taster delete

d. Selektovati red i kliknuti na Backspace taster
17. Kombinacija tastera u Wordu Ctrl + A označava

a. Align

b. Select All

c. Auto format

d. Add row

18. Ako želimo u Wordu da selektujemo sve do kraja reda odabraćemo sledeću kombinaciju tastera

a. Shift + PageDn

b. Shift + End

c. Shift + left

d. Ctrl + PageDn

e. Ctrl + End

f. Ctrl + left

g. Shift + Ctrl + PageDn

h. Shift + Ctrl + End

i. Shift + Ctrl + left 

19. Kombinacija tastera u Wordu Ctrl + Shift + End označava

a. Ne znači ništa

b. Selektuje tekst do kraja reda

c. Pomera pokazivač na kraj reda

d. Selektuje tekst do kraja dokumenta

20. U programu Word pomoću tastera PageUp se pomeramo za:

a. Jedan list papira na gore

b. Jedno poglavlje na gore

c. Jedan ekranski prikaz na gore

d. Jednu sekciju na gore
21. Pretraživanje teksta u programima koji se bave tekstom se radi pomoću prečice:

a. F1 (tasterom)

b. Alt + F (tasterom)

c. F10 (tasterom)

d. Ctrl + F (kombinacijom tastera)
22. U programu Excel, funkcjaa koja izračunava prosečnu vrednost brojeva koji se nalaze u odabranim ćelijama je:

a. SUM

b. AVERAGE

c. PRODUCT
23. U programu Excel otvaranjem menija Insert->Chart pokreće se:

a. Crtanje specijalnih simbola

b. Crtanje geometrijskih figura

c. Crtanje grafikona
24. Kako u Excel-u da izračunamo srednju vrednost za polja između A3 i A17 pri čemu se ta polja nalaze na drugom radnom listu (Sheet2)

a. Sheet2!AVERAGE(A3:A17)

b. AVERAGE(A3:A17)->Sheet2

c. AVERAGE(Sheet!A3:Sheet!A17)

d. Nije moguće izračunati srednju vrednost iz vrednosti sa drugog radnog lista
25. Treba da kreiramo niz podataka u C koloni koji se dobija tako što se podaci iz B kolone od reda 3 do reda 18 množe sa brojem u ćeliji A2. Kako izgleda formula u ćeliji C3 koju možemo posle da kopiramo u ostale ćelije?

a. A1*B3

b. A1*$B3

c. $A$1*B3

d. A$1*B$3
26. Ako tekst koji se nalazi u ćeliji A1 radnog lista Sheet1 želimo da prikažemo u ćeliji radnog lista Sheet2 ali sa sve velikim slovima. To može da se uradi na sledeći način.

a. Sheet1!A1

b. =BigChar(A1!Sheet1)

c. =Upper(A1!Sheet1)

d. =Up(A1!Sheet1)

e. Nije moguće se pozivati na podatke sa drugih radnih listova.
27. Koja od navedenih formula nam obezbeđuje sledeće ponašanje. Ako je podatak na polju E18 D onda treba u ćeliji da stoji vrednost iz polja G18 a ako ne u polju treba da stoji suma podataka od ćelije F1 do ćelije F18

a. IF(E18="D",G18,SUM(F1:F18))

b. IF (E18="D") THEN (G18) ELSE (SUM(F1:F18))

c. IF(E18="D";G18;SUM(F1:F18))
28. Koja od navedenih formula nam obezbeđuje sledeće ponašanje. Ako je podatak na A1 veći od 10  onda treba ćelija da ostane prazna a ako podatak nije veći od 10 onda u polju treba da stoji taj podatak.

a. IF(A1<10,"",A1)

b. IF (A1<10) THEN ("") ELSE (A1)

c. IF(A1>10;"";A1)

29. Koliko formula možemo da ugnježdavamo (ubacujemo jednu u drugu) u Excelu iz paketa Office 2000

a. 5

b. 7

c. 9

d. 32

e. Nije ograničeno
30. Kako u Excel-u da izračunamo sumu vrednost za polja između A3 i A17 pri čemu se ta polja nalaze na drugom radnom listu (Sheet2)

a. Sheet2!SUM(A3:A17)

b. SUM(A3:A17)->Sheet2

c. SUM(Sheet2!A3:Sheet2!A17)

d. Nije moguće izračunati sumu vrednost za vrednosti sa drugog radnog lista
31. Imamo u ćeliji C1 vrednost evra. U koloni A od polja 3 imamo vrednosti u dinarima. U koloni B od polja 3 treba da imamo vrednosti u €. Formula koju ćemo kopirati posle u sve ostale ćelije kolone B a kreiraćemo u ćeliji B3 će izgledati?

a. A3*C1

b. A3*$C1

c. A3/$C$1

d. A3/C1

e. A3/$C1
32. Excel: Ako je potrebno u okviru izraza neku vrednost, na primer C2 fiksirati, onda će na u izrazu biti definisana sa?

a. C2

b. $C2

c. $C$2

d. C$2

e. C$2$

33. Ako imamo podatak u polju A5 (odnos koeficijenta plate i bodova) i želimo da sva polja u koloni C od reda 2 do reda 58 izračunaju vrednost u plate a u koloni B imamo vrednost bodova od reda 2 do reda 58 to možemo da postignemo tako što ćemo formulu da napišemo u prvu ćeliju C2 i onda ćemo samo (markerom) da prevučemo preko ostalih ćelija do C58. Formula u polju C2 će glasiti:

a. A5*B2

b. A5*$B2

c. $A$5*B2

d. A$5*B$2
34. Koja od navedenih formula nam obezbeđuje sledeće ponašanje. Ako je podatak na polju E18 “Da” onda treba u ćeliji da stoji vrednost “Položio” a ako podatak nije “Da” u polju treba da stoji “Pao”

a. IF(E18="Da",”Položio”,”Pao”)

b. IF (E18="Da") THEN (“Položio”) ELSE (“Pao”)

c. IF(E18="Da";“Položio“;“Pao“)
35. Koja od navedenih formula nam obezbeđuje sledeće ponašanje. Ako je podatak na polju J10 “Ispravan” onda treba u ćeliji da stoji vrednost “Ispravan” a ako podatak nije “Ispravan” u polju treba da stoji “Nije ispravan”

a. IF(J10="Ispravan",”Ispravan”,”Nije ispravan”)

b. IF (J10="Ispravan") THEN (“Ispravan”) ELSE (“Nije ispravan”)

c. IF(J10="Ispravan";“Ispravan“;“Nije ispravan“)

36. Šta se dešava ako u nekoj ćeliji u kojoj izračunavamo rezultat neke formule ne može rezultat da stane u ćeliju (veći je od šitine ćelije)

a. Biće prikazan samo onaj deo rezultata koji može da stane

b. Biće prikazana poruka o grešci (Error...)

c. U ćeliji će bit umesto brojeva ispisani ######

d. Ćelija će biti prazna
37. Ako želimo da prikažemo podatak koji se nalazi u radnom listu Sheet1 u ćeliji A3 u okviru druge ćelije na taj podatak možemo da se pozovemo na sledeći način

a. Sheet1!A3

b. A3!Sheet1

c. Sheet1:A3

d. Nije moguće se pozivati na podatke sa drugih radnih listova.
38. Ako podesite da je format za prikazivanje datum dd/MM/yy onda će se datum (29. Maj 2011) prikazati kao:
a. 05/29/11

b. 11/05/29
c. 29/05/11

d. 29/11/05
39. Excel: Ako imamo u ćelijama od A1 do A24 brojeve od 1 do 24 šta će da nam vrati funkcija =COUNTIF(A1:A24,">10")
a. 24

b. Grešku

c. 14

d. 10
40. Ako imamo sledeću Excel tabelu

	
	A
	B

	1
	20
	10

	2
	10
	15

	3
	20
	20

	4
	30
	25

	5
	20
	30


i treba da saberemo sve brojeve iz kolone B kada u koloni A imamo broj 20. To ćemo postići sa sledećom formulom?
a. =SumIf(A2:A6, 20, C2:C6)

b. =CountIf(C2:C6, 20)

c. =Sum(A2:A6, 20, C2:C6)

d. =If(A2:A6, 20, C2:C6)
41. U Excel-u zašta se koristi uslovno formatiranje?

a. Da bi se drukčije formatirale ćelije koje ispunjavaju neki uslov

b. Ne postoji ovakva opcija u Excelu

c. Za kreiranje vizuelno atraktivnih grafikona
42. Pomoću koje prečice se u Windows Exploreru prelazi u roditeljski direktorijum

a. Ctrl + Back

b. Back

c. Up (strelčica na gore)

d. PageUp
43. Osvežavanje prikaza Windows Explorera se radi pomoću?

a. F5 (tastera)

b. Ctrl + R (kombinacije tastera)

c. Ctrl + C (kombinacije tastera)

d. F2 (tastera)
44. Times New Roman spada u grupu? (zaokružiti sve tačne odgovore)

a. Serifni proporcionalni font

b. Neproporcionalni font

c. Ne serifni ne proporcionalni font
45. Čemu služi program Scan Disk

a. Defragmentaciji hard diksa

b. Formatira disk

c. Proveravanju ispravnost strukutre foldera i fajlova

d. Skenira disk u potrazi za konkretnim dokumentom
46. Koji program za obradu rasterskih slika dolazi sa operativnim sistemom Windows XP?

a. Draw

b. Paint

c. PhotoShop

d. GIMP
47. Koji je najpoznatiji besplatni-OpenSource program za obradu rasterskih slika?

a. Paint

b. ACDSee

c. GIMP

d. PhotoShop
48. Aplikacija GIMP je OpenSource besplatno rešenje koje može da zameni?

a. Word

b. PowerPoint

c. WinCommander

d. CorelDraw

e. Photoshop
49. Power Point 2010 ima extenziju

a. ppt

b. pot

c. pptx

d. odp
50. Aplikacija Power Point je deo kog paketa programa

a. MS Office

b. MS Visual Studio

c. Adobe CS

d. iWorks

51. Power Point template ima extenziju

a. otp

b. pot

c. ppt

d. odp
52. Open Office zamena za Microsoft PowerPoint se zove?

a. Presentation

b. Show Presentation

c. Drawing

d. Keynote
53. Aplikacija AutoCad je namenjena?

a. Radu sa 3D modelima

b. Radu sa Vektorskom grafikom

c. Radu sa rasterskom grafikom

d. Radu sa fontovima

54. Web pretraživač kompanije Google se zove?

a. Chrome

b. Safari

c. GOS

d. Google Browser
55. Za obradu fotografija koristi se program:

a. Adobe Photoshop

b. AutoCad

c. 3D Studio Max
HTML

HTML je strukturalni programski jezik koji služi za kreiranje dokumenta na World Wide Web-u. Koristi se za stvaranje hipertekstualnih datoteka.  HTML je skraćenica od Hyper Text Markup Language. 
Da bi se napravila Web stranica neophodan je najobičniji tekst editor kao što je Notepad eventualno Notepad++.  Osim Notepad-a neophodan nam je i Web Browser. Preporučljivo je da se na kompjuteru poseduje više od jednog browser-a kako bi se izgled Web stranice mogao proveriti u oba. Različiti browseri različito tumače pojedine HTML tagove. Ponekad su potrebne korekcije kako bi Web stranice imale dobar izgled u različitim browserima. Naravno pozeljno je i da se poseduje i  neki program za obadu grafike(Photoshop, Corel photo paint...) kako bi se kreirale grafičke datoteke koje će se ugraditi u Web stranice. Doduše na Internetu izuzetno je lako pronaći mnogo Web grafike koja se besplatno skida i koja se može ugraditi u Web stranice.
1. Microsoft Internet Explorer se koriste za:

a. Za prikaz hipertekst dokumenata

b. Za prikaz URL dokumenata

c. Za čitanje datoteka u veb formatu

d. Za prikaz hiperlinkova

e. Za prikaz datoteka u veb formatu

2. Program Firefox se koriste za:

a. Za prikaz hipertekst dokumenata 

b. Za čitanje datoteka u veb formatu  

c. Za prikaz hiperlinkova  

d. Za prikaz datoteka u veb formatu  

e. Za prikaz URL dokumenata  

3. U HTML jeziku, set tagova i atributa je:

a. Definisan standardom

b. Definisan  HTTP protokolom

c. Stvar dogovora korisnika

d. Nije definisan

e. Definisan XML jezikom

4. Veb čitač ima zadatak da veb serveru pošalje:

a. HTTP zahtev

b. XML zahtev

c. URL zahtev

d. Traženu HTTP datoteku

e. HTML zahtev

5. Veb sajt je:

a. Kolekcija hipertekst stranica  

b. Sever na kome je publikovan sajt  

c. Kolekcija URL-ova  

d. Kolekcija URI-ja  

e. Kolekcija hiperlinkova

6. PHP je skript jezik koji se koristi za:

a. Programiranje serverske strane

b. Za pisanje HTML strana

c. Za opis XML jezika

d. Za pisanje XML jezika

e. Kreiranje malih programskih komponenti ili kontrola unutar veb strane

7. JavaScript je jezik koji se koristi za:

a. Programiranje klijentske strane

b. Za pisanje HTML strana

c. Programiranje serverske strane

d. Za pisanje XML jezika

e. Za opis XML jezika

8. Koji je jezik za opis web strane?

a. HTML

b. Java Script

c. Paskal
9. U HTML-u boje se zadaju u kom formatu?

a. Kao tri decimalna broja u zagradama (255,0,0)

b. Kao zapis u pokretnom zarezu u vrednosima od 0 do 1 (1.0, 0.5, 0.5)

c. Kao heksadecimalnom zapisu od 0 do F #FF00AA
10. Ako boje predstavljamo u hexadecimalnom obilku onda oznaka #FFFF00 predstavlja koju boju?

a. Bela

b. Žuta

c. Zelena

d. Plava

e. Crvena
11. U HTML iskazu <h1 align="left">Naslov</h1> , član align je:

a. Atribut

b. Karakter referenca

c. Startni tag

d. Završni tag

e. Referenca

12. Jedan od sledecih tagova je karakteristican po tome što nema sadržaj. Koji? 

a. p

b. br

c. align

d. center
13. Šta je HTML?

a. Hyper Text Markup Language
b. Home Tool Markup Language
c. Hyperlinks and Text Markup Language
14. Ko pravi Web standarde? 

a. Netscape
b. The World Wide Web Consortium

c. Microsoft
15. Odaberite korektan HTML tag za najveće zaglavlje. 

a. <head>
b. <h6>
c. <heading>
d. <h1>

16. Šta je ispravan HTML tag za umetanja prekida linije?

a. <lb>
b. <br/> 

c. <break>
17. Odaberite ispravan HTML tag da učinite tekst podebljanim:

a. <bld>
b. <bold>
c. <b> 

d. <bb>
18. Odaberite ispravan HTML tag da učinite tekst nakošenim (kurziv):

a. <i> 

b. <italics>
c. <ii>
19. Koji je tačan HTML iskaz za kreiranje hiperlinka?

a. <a url="http:// www.apple.com">Apple.com</a>
b. <a name="http:// www.apple.com ">Apple.com</a>
c. <a>http://www.apple.com </a>
d. <a href="http:// www.apple.com ">Apple</a>
20. Kako možete da napravite e-mail link?

a. <mail href="xxx@yyy">
b. <mail>xxx@yyy</mail>
c. <a href="mailto:xxx@yyy"> 

d. <a href="xxx@yyy">
21. Kako možete da otvorite link u novom prozoru pretraživača?

a. <a href="url" new>


b. <a href="url" target="_blank"> 

c. <a href="url" target="new">
22. Koji od ovih HTML tagova se odnose na tabele?

a. <table><head><tfoot>
b. <table><tr><tt>
c. <thead><body><tr>
d. <table><tr><td> 

23. Kako možete da napravite listu koja nabraja stavke sa brojevima?

a. <dl>
b. <ul>
c. <list>
d. <ol> 

24. Kako možete da napravite listu koja nabraja stavke sa znacima za nabrajanje (crtica, tačka i drugo)?

a. <list>
b. <ul> 

c. <dl>
d. <ol>
25. Šta je ispravan HTML za pravljenje čekboksa?

a. <input type="checkbox"> 

b. <input type="check">
c. <check>
d. <checkbox>
26. Koja je korektna HTML sintaksa za kreiranje polja za unos teksta?

a. <textfield>


b. <input type="textfield">
c. <input type="text"> 

d. <textinput type="text">
27. Šta je ispravni HTML za pravljenje drop-down liste?

a. <input type="list">
b. <select>

c. <list>
d. <input type="dropdown">
28. Šta je ispravan HTML za umetanje slike? 

a. <img src="image.gif"/> 
b. <img href="image.gif"/>
c. <img>image.gif</img>
d. <image src="image.gif">
29. Koji HTML tag (u okviru <>) korisnik ne vidi, a sadrži informacije o Web strani ili sajtu?

a. span
b. keywords
c. meta 

d. body
30. Koju ulogu u tagu <img src="lopta.gif" alt="Lopta"/>, ima alt atribut?

a. Prikazuje tekst "Lopta" ukoliko učitavana slika lopta.gif ne može da se prikaže

b. Predstavlja vezu sa slikom Lopta
c. Daje alternativni fajl u slučaju da je prvi oštećen
d. Daje alternativni fajl u slučaju da .gif fajlove pretraživač ne može da preuzme
31. Koja je sintaksa za HTML tagove?

a. name="value"
b. <html> 

c. ${html}
d. <%html%>
32. Šta je ispravna sintaksa za umetanje horizontalne linije?

a. <line/>
b. <tr>
c. <line horizontal="true">
d. <hr/> 

33. Kako definišete stil fonta teksta?

a. <text style="Arial">
b. <font style="Arial"></font> 

c. <style="Arial">

d. <text=Arial>
34. Gde su smešteni tagovi i tekst koji se ne prikazuje direktno na strani?

a. title
b. body
c. tables
d. head 

35. Pored taga <b>, drugi način da se napravi tekst bold je?

a. <fat>
b. <dark>
c. <strong> 

d. <emp>


36. Koji tag se koristi za umetanje slika u veb stranice?

a. img 

b. image
c. pic
d. scr

37. Da bi dodali redove u vašoj tabeli koje tagove koristite?

a. <th>...</th>
b. <br/>

c. <td>...</td>

d. <tr>...</tr> 

38. Koji atribut specificira gde da pošaljete formu?

a. method
b. output


c. action 

d. input
39. Šta je ispravni XHTML za paragraf?

a. <p></p> 

b. </p><p>
c. <P></P>
d. <P></p>
40. Koji HTML kod je "dobro-formatiran"?

a. <p>A <b><i>short</i></b> paragraph
b. Ništa od navedenog
c. <p>A <b><i>short</i></b> paragraph</p>

d. <p>A <b><i>short</b></i> paragraph</p>
CSS

CSS je skraćenica za Cascading Style Sheets. Naziv kaskadni dolazi od činjenice da izmena nekog elementa HTML strane automatski sa sobom povlači istu izmenu na svim pod elementima tog elementa. Na primer ako postavimo da paragraf (tag <P>) ima neki stil, recimo font teget boje, onda će i svi elementi koji se nalaze u tom tagu imati istu vrednost, recimo stavimo deo teksta u okviru paragrafa u bold (<B>) on će i dalje biti teget boje. 

Glavna prednost upotrebe CSS-a je u mogućnosti centralizovanog pristupa izgledu sajta. Ako se radi na iole većem sajtu onda je neophodno imati centralizovano upravljanje izgledom sajta. Na primer imamo sajt sa preko 100 strana (ne tako redak slučaj u praksi) i želimo da promenimo bojevnu šemu na sajtu. Recimo da sa nijansa zelene pređemo na nijanse smeđe. Dakle, potrebno je svakoj pozadini i svakom tekstu da se promeni boja. Ovo je ogroman posao ako bi morali da otvaramo svaku HTML stranu posebno i da tražimo boje i menjamo ih. Sa druge strane ako imamo jedan fajl u kome se nalaze sva podešavanja boje na sajtu onda možemo samo da izmenimo u tom jednom fajlu svaku boju i time izmenimo kompletan sajt ma koliko stranica imao.

Osim značajne pomoći u centralizaciji vizuelane prezentacije sajta CSS ima još jedan značajan doprinos izgledu HTML prezentacije. Naime, pomoću CSS-a možemo da unesemo dodatna podešavanja pomoću kojih je moguće veoma precizno pozicionirati neki element i podesiti njegove parametre. Mnogo detaljnije i preciznije nego što je to moguće sa HTML-om. Zahvaljujući CSS-u moguće je napraviti grafički veoma bogate sajtove jer je uz pomoć CSS-a moguće precizno pozicionirati sve elemente sajta. 
1. Skraćenisa CSS predstavlja?

a. Counter Strike Session

b. Computer System Session

c. Cascading Style Sheets

d. Computer Style Session
2. Šta je ispravan HTML za upućivanje na eksterni style sheet?

a. <link rel="stylesheet" type="text/css" href="mystyle.css">

b. <style src="mystyle.css">
c. <stylesheet>mystyle.css</stylesheet>

3. Gde u HTML dokumentu je preporučeno mesto da se uputi na eksterni style sheet?

a. Na vrhu dokumenta
b. Na kraju dokumenta

c. U <body> sekciji
d. U <head> sekciji
4. Koji HTML tag (kontrolni kod) se koristi da definiše interni style sheet?

a. <css>
b. <script>

c. <style>
5. Koji HTML atribut se koristi da definiše inline stilove?

a. class
b. font
c. style

d. styles

6. Koja CSS sintaksa je ispravna?

a. {body:color=black(body}
b. body {color: black}

c. body:color=black
d. {body;color:black}

7. Kako umećete komentar u CSS fajl?

a. ' ovo je komentar
b. // ovo je komentar
c. // ovo je komentar //
d. /* ovo je komentar */
8. Koje svojstvo (osobina) se koristi za promenu boje pozadine u CSS-u?

a. bgcolor:
b. color:
c. background-color:
9. Kako dodajete boju pozadine za sve <h1> elemente?

a. all.h1 { background-color: white }
b. h1 { background-color: white }

c. h1:all { background-color: white }

10. Kako se menja boja teksta elementa u CSS-u?

a. color:

b. text-color=
c. fgcolor:
d. text-color:

11. Koja CSS osobina kontroliše veličinu teksta?

a. font-style
b. text-style
c. font-size

d. text-size
12. Šta je ispravna CSS sintaksa za pravljenje svih <p> elemenata bold?

a. <p style="font-size:bold">
b. <p style="text-size:bold">
c. p { font-weight:bold }

d. p { text-size:bold }

13. Kako da prikažete hipelinkove bez podvlačenja?

a. a { text-decoration:none }

b. a { text-decoration:no underline }
c. a { underline:none }
d. a { decoration:no underline }

14. Kako se menja font elementa u CSS-u? 

a. font=
b. f:
c. font-family:
15. Kako pravite tekst boldiranim? 

a. style:bold
b. font-weight:bold

c. font:b

16. Kako se menja leva margina elementa u CSS-u? 

a. margin-left:

b. text-indent:
c. indent:
d. margin:

17. Kako pravite listu koja lista sve stavke sa kvadratima?

a. type: 2


b. type: square
c. list-type: square
d. list-style-type: square
18. CSS može biti definisan za čitave sajtove jednostavnim pisanjem CSS definicije gde?

a. Body sekcija svake strane
b. Head sekcija svake strane
c. CSS dokumenta

d. Ništa od navedenog

19. Šta od sledećeg NIJE važeći CSS selektor?

a. H1 - H3 { ... }

b. A:hover { ... }
c. H1 + H3 { ... }
d. A#id { ... }

20. U CSS-u, osobina font-style može da napravi tekst?

a. Većim

b. Različitih boja
c. Italic
d. Sve navedeno

21. Na koliko načina se mogu uključiti stilovi u HTML stranicu?

a. 2 - Unutar style elementa i eksternom fajlu
b. 3 - U samom tagu, unutar style elementa i eksternim fajlom

c. 4 - U samom tagu, unutar style elementa, eksternim fajlom i kroz meta tag
d. Stilovi se ne definišu u HTML-u nego u CSS-u

22. Šta definiše selektor stila?

a. Sa kojim HTML elementima treba upariti pravilo

b. Veličinu prozora pretraživača
c. Akciju koju treba izvršiti prilikom prikaza


d. Ništa od navedenog
JS

Osnovni problem rada sa HTML-om je ne mogućnost interakcije sa korisnikom. HTML strane su statične i nemaju interakciju. Ovo je veliki nedostatak standardnih HTML strana. JavaScript je standardizovan programski jezik koji se koristi u Browser-ima. Ovaj programski jezik nadomešćuje nedostatke standardnog HTML-a obezbeđujući elementarnu interakciju sa korisnikom. Ovaj programski jezik je modularnog tipa pa samim tim nije za komplikovanije zadatke. Iako JavaScript ima svoje objekte ovo nije objektni programski jezik. Ovaj programski jezik je takođe i interpreterski što znači da njegov kod browser interpretira dok se stranica prikazuje. Odnosno ne kompajlira se već se sam kod nalazi u tekstualnom obliku kad dođe do korisnika pa se implementira od strane Browsera u tom trenutku.

Trebalo bi programiranje u ovom programskom jeziku ograničiti samo na one oblasti za koje je ovaj jezik namenjen a to je dinamička izmena teksta, reagovanje na događaje korisnika, validacija formi, kreiranje vizuelno atraktivnih dinamičkih efekata, a može da se korisit i za specifične situacije kada je potrbno da se pristupi određenim mogućnostima koje ima samo pojedinačni Browser. Onda može pomoću ovog programskog jezika da se napravi dvostruka funkcionalnost kad je jedan Browser da se izvršava jedan kod a kad je drugi, drugi kod.

Koristi se za:

· dinamičku izmenu teksta

· reagovanje na događaje korisnika

· validaciju formi na klijentskoj strani

· dinamičke vizuelne efekte

· detekciju korisnikovog Browser-a
23. Unutar kog HTML elementa se stavlja JavaScript? 

a. <javascript>

b. <script>

c. <js>

d. <scripting>
24. Šta je ispravna JavaScript syntaksa za ispisivanje poruke "Hello, World!" unutar stranice? 

a. response.write("Hello, World!");

b. $("Hello, World!");

c. window.open("Hello, World!");

d. document.write("Hello, World!");
25. Gde se u okviru HTML strane može staviti JavaScript?

a. <head> sekcija

b. i u okviru <head> sekcije i u okviru <body> sekcije

c. <body> sekcija
26. Šta je ispravna sintaksa da se uputi na spoljašnji skript koji se zove "external.js"?

a. <script name="external.js">

b. <script href="external.js">

c. <script src="external.js">
27. Spoljašnji JavaScript mora da sadrži <script> tag?

a. Treba, ali nije obavezno

b. Da, mora da sadrži HTML elemente

c. Ne sme da sadrži <script> tag jer nije HTML
28. Kako pišete "Hello World" u boksu upozorenja?

a. message("Hello World")

b. alertBox="Hello World"

c. alert("Hello World")

d. alertBox("Hello World")
29. Kako se kreira funkcija u JavaScript-u?

a. function=myFunction()

b. function myFunction()

c. function:myFunction()
30. Kako pozivate funkciju sa imenom "myFunction" u JavaScript-u?

a. call myFunction()

b. call function myFunction

c. myFunction()
31. Kako pišete uslovni iskaz za izvršavanje nekih iskaza samo ako je "i" jednako 5?

a. if i=5 then

b. if (i==5)

c. if i==5 then

d. if i=5
32. Kako pišete uslovni iskaz za izvršavanje nekih iskaza samo ako je "i" NIJE jednako 5?

a. if (i != 5)

b. if (i <> 5)

c. if =! 5 then

d. if <>5
33. Koliko različitih vrsta petlji postoji u JavaScript-u?

a. Dve - "for" petlja i "while" petlja

b. Pet - "for", "while" "do...while", "loop...until" i "goto" petlja

c. Tri - "for" petlja i dve "while" petlje
34. Koje je ispravno zaglavlje "for" petlje

a. for (i <= 5; i++)

b. for i = 1 to 5

c. for (i = 0; i <= 5; i++) 

d. for (i = 0; i <= 5)
35. Kako se pišu komentari u JavaScriptu?

a. <!-- Ovo je komentar -->

b. // Ovo je komentar

c. ; Ovo je komentar (iza tačka-zareza)
36. Koja je ispravna sintaksa JavaScripta za umetanje komentara dužih od jedne linije?

a. /* Ovaj komentar ima više od jedne linije */

b. // Ovaj komentar ima više od jedne linije //

c. <!-- Ovaj komentar ima više od jedne linije -->
37. Izaberite ispravan kod za inicijalizaciju nizova u JavaScript-u?

a. var txt = new Array = "tim", "kim", "jim"

b. var txt = new Array("tim", "kim", "jim")

c. var txt = new Array: 1=("tim") 2=("kim" )3=("jim")

d. var txt = new Array(1:"tim", 2:"kim", 3:"jim")
38. Koja su, od navedenih, ispravna imena promenljivih u JavaScript jeziku?

a. Default

b. firstText

c. _first Text

d. 1stText
39. Obično je preporučljivo čuvati što je moguće više JavaScript koda u kojoj sekciji?

a. Layer

b. Title

c. Head

d. Body
40. JavaScript linije se završavaju sa čim?

a. zarezom

b. tačkom i zarezom

c. dve tačke

d. zagradom
41. Najčešći način da dodelimo vrednost promenljivoj je korišćenjem čega?

a. Znaka jednakosti

b. HTML

c. Njenim imenovanjem

d. CSS
42. a++; ima isto značenje kao koja od sledećih naredbi:

a. a += 1;

b. a=+1;

c. c++;

d. a = 1;
43. Kada upoređujete promenljive po jednakosti, šta koristite od sledećeg?

a. =

b. !=

c. ??

d. ==
44. Da se kod ne bi izvršio odmah po učitavanju stranice, možemo ga definisati kao:

a. funkciju

b. kašnjenje

c. thread

d. fleksibilan kod
45. Akcije koje mogu biti detektovane od strane JavaScripta zovu se?

a. Događaji

b. HTML

c. Array (nizovi)

d. Objekti
46. Da li JavaScript razlikuje mala od velikih slova u nazivima?

a. Da

b. Samo u nazivu funkcija

c. Ne

d. Samo početno slovo promenljive
Opšta računarska pitanja
1. Koji od navedenih proizvođača više ne proizvodi laptop računare?

a. Apple

b. HP

c. IBM

d. Lenovo
2. Kućište na koje se drži monitor spada u tip?

a. Minitower

b. Tower

c. Desktop

3. Peer-to-peer mreža je mreža?

a. Mreža za razmenu nedozvoljenog sadržaja

b. Mreža ravonopravnih korisnika

c. Zaštićena mreža za razmenu poslovnog sadržaja
4. Pod domen org je rezervisan za?

a. Obrazovne institucije

b. Ne profitabilne organizacije

c. Korporaacije

d. Vladine institucije
5. Jedan inč je približno:

a. 25,4mm

b. 31,2mm

c. 18.7mm

d. 21.2mm

6. Deo tastature koji se nalazi sa krajnje desne strane tastature i koji služi za unos brojeva i osnovnih aritmetičkih operacija zove se:

a. Funkcijski deo tastaure

b. Numerčki deo tastature

c. Alfanumerički deo tastature
7. Šta označava skraćenica XML?

a. Extensible Markup Language

b. Extreme Mother Language

c. Extendable Main Language
8. Šta označava pojam Virtuelizacija?

a. Proširivanje fizičke memorije upotrebom hard diska.

b. Pokretanje više aplikacija na istom operativnom sistemu.

c. Pokretanje više operativnih sistema paralelno na istom fizičkom računaru.
